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About This Guide
This guide describes how to install or upgrade the Polaris® Integrated Library System
server and client software. It does not cover detailed procedures for staging a new
server or installing and using Microsoft® Windows® software. If you need assistance
with these procedures, consult your Microsoft documentation and/or contact your
Polaris Site Manager. Support technicians can help with your specific situation. The
information in this guide is intended for system administrators.

Polaris Installation Topics
Important:
For information about developments that may have occurred after this
information was published, go to
https://innovative.libguides.com/PolarisHome.
This guide covers the following topics:
l

Polaris 7.2 Requirements: Polaris software requirements: server configurations,
special installation considerations.

l

Server Installation and Upgrades: Staging a new Polaris server (overview),
installing Polaris server software, installing INN-Reach, licensing, date and
currency formats, changing SQL user password, upgrades.

l

Client Installation: Installing Polaris Windows Components Updates software and
client software (staff client, Polaris SIP, Polaris NCIP, Polaris® ExpressCheck™);
Automatic, Group Policy, and System Center deployment methods; RFID for Polaris
hosted and terminal server environments.

Related Resources
The following resources may be useful when installing and configuring Polaris server
and client software:
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l

Polaris System Administration training: Contact your Innovative Interfaces
Customer Sales representative for details.

l

Microsoft Windows server and workstation documentation

l

Polaris Administration information: These materials cover how to set up Polaris
for your library, and how to use Polaris Administration to customize Polaris:

l

l

o

Polaris staff client help

o

Polaris® ExpressCheck™ Administration Guide

Polaris Customer Supportal:
o

For updated user and support information, go to
https://innovative.libguides.com/PolarisHome.

o

For more information about system requirements, see the latest Polaris
Operating System Requirements.

Polaris Site Manager: Contact your Site Manager at (877) 857-1978.
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Polaris 7.2 Requirements
Innovative Interfaces installs Polaris ILS software for new customers during equipment
staging or equipment installation. The operating system, all service packs, Microsoft
Windows components, and Polaris software are installed on the servers. However, if you
are setting up new computers or restoring a computer after disaster recovery, follow the
procedures for new installations in this guide.
The Polaris installation software includes both server and client installations. The
Polaris Windows Components Update, which installs most of the prerequisites you need
to run Polaris, is integrated into the Polaris client software installation process.
Current customers can upgrade to Polaris 7.2 from Polaris version 5.0 (191) or later.
This unit covers the following topics:
l

Servers

l

Staff Client Requirements

l

Polaris PowerPAC Browsers

l

Reports

l

Network Security

l

Terminal Server and Printers

l

Polaris for Consortia

l

Polaris Authentication

l

Licenses

Servers
Important:
Review all licensing issues and requirements whenever you install any
Microsoft products. Current Microsoft Service Packs must be applied to
all server and workstation system software before you upgrade.
Polaris 7.2 servers require one of the following operating systems:
l

Windows Server 2019 64-bit (Standard, Enterprise, Datacenter editions)

l

Windows Server 2016 64-bit (Standard, Enterprise, Datacenter editions)
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l

Windows Server 2012 R2 64-bit (Standard, Enterprise, Datacenter editions)

Additional required support software is installed automatically as part of the Polaris
Client Installer software.
If you do not have a separate server for Reporting Services, the Polaris production server
is used by default. See Reports for more information about Reporting Services.
Polaris Database Server
The Polaris database server holds your Polaris records, such as patron records,
bibliographic records, and item records. The Polaris database requires one of the
following Microsoft SQL Server releases:
l

Microsoft SQL Server 2019 64-bit

l

Microsoft SQL Server 2017 64-bit

l

Microsoft SQL Server 2016 (SP2) 64-bit

l

Microsoft SQL Server 2014 (SP3) 64-bit

l

Microsoft SQL Server 2012 (SP4) 64-bit

The database server also processes statistical transactions, so it requires Microsoft
Message Queuing (MSMQ). Microsoft SQL Server Native Client is installed, if necessary,
as part of the software installation process.
Web Server
The web server hosts Polaris® PowerPAC™, Polaris® Mobile PAC™, and Polaris®
PowerPAC™ Children’s Edition. In addition, the Polaris Phone Attendant (inbound
telephony) uses the web server to store certain settings. For a list of web server
components, see Web Server Component Features.
RAM Recommendations for Single-Server Environments
The following RAM amounts are recommended for Polaris 7.2 in single-server
production environments:
l

16 GB of RAM for up to 5 million circ transactions annually

l

32 GB of RAM for up to 10 million circ transactions annually

l

64 GB of RAM for up to 15 million circ transactions annually

For 10-user training servers, a minimum of 8 GB of RAM is recommended.
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The annual circulation transactions criterion is simply a guideline; your requirements
may differ depending on the size of your database and the number of users. Also, if you
will implement integrated federated searching, you may need additional server RAM.

Staff Client Requirements
Important:
Review all licensing issues and requirements whenever you install any
Microsoft products. Current Microsoft Service Packs and additional
updates, including all versions of the .NET Framework, must be applied to
all server and workstation system software before you upgrade.
The Polaris ILS staff client application includes Polaris administration, acquisitions,
serials, cataloging, circulation, and patron services functions. One of the following
operating systems must be installed on every staff client computer:
l

l

Windows 10 32-bit or 64-bit, Anniversary Update (version 1607) or later
o

Professional, Ultimate, or Enterprise edition

o

RAM: 4GB recommended

Windows 8.1 32-bit or 64-bit
o

Professional, Ultimate, or Enterprise edition

o

RAM: 2GB recommended

Additional required software for all workstations is installed automatically as part of the
Polaris Client Installer.
The Polaris 7.2 staff client is optimized for monitors with 1024 x 768 resolution.

Polaris PowerPAC Browsers
Polaris PowerPAC, the web-based PAC application, is based on Asynchronous
JavaScript™ and XML (AJAX) programming. AJAX-compatible browsers include
Chrome, Firefox, Edge, and Safari.
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Reports
Polaris uses SQL Server Reporting Services for reports and notices, as well as most
printing tasks in the staff client. Microsoft Report Manager and Report Designer (if you
customize reports) are installed on your report “server,” which may be located on your
Polaris production server or another server you specify.
In Polaris Administration, you specify the URL for the Report Manager and report
service. Because report definitions, folders, and resources are published and managed
as a web service, SQL Server Reporting Services requires access to the web server.
Reporting Services uses Windows authentication by default. If you want to change the
default account that is authenticated to the report server, you can do so in Polaris
Administration. If you use a proxy server, you also specify the proxy server for use with
reporting services in Polaris Administration. Use the staff client profiles Report Server
and Proxy Server, available at the system, library, and branch levels, to specify the
servers. In a consortium, different servers can be specified for different organizations as
appropriate.
Note:
The web interface for Reporting Services supports only Internet Explorer,
although other browsers may work.

Network Security
Polaris customers are responsible for maintaining the security of their networks,
servers, and clients. You need to maintain a firewall, and keep antivirus software and
software patches current on servers and clients. For more information, see the
Customer Supportal, which provides detailed information about security planning,
security tools and downloads, and Polaris policies.

Terminal Server and Printers
If you are operating Polaris in a terminal server environment, the drivers for the printers
used by local workstations must be installed on the terminal server. The printers must
be terminal server-certified. Install Print Management, then add the terminal server
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computer name to Print Management. Expand the new server name, right-click Add
Drivers, and install the necessary print drivers.

Polaris for Consortia
Polaris provides extraordinary opportunities for independence and flexibility to
consortium members sharing the database. Consortium-wide decisions regarding
processes and workflow are few, so that member organizations can operate in ways
that best serve their patrons while drawing on the database resources of the consortium
as a whole. Polaris provides flexible policies down to the branch level. In addition, even
though consortium members share the database, member libraries own their records.
These are protected by access and modification permissions.
However, if your situation requires it, you can set up Polaris to function in an application
service provider (ASP) environment. In this model, a library consortium with one Polaris
installation can have multiple Polaris databases. The catalogs are not shared or
mutually accessible (unless a consortium member sets up another member’s Polaris
database as a remote search target), and patron information is not shared.
Note:
The ASP model requires at a minimum SQL Server Standard Edition.
Innovative Interfaces helps you set up Polaris for an ASP environment. When you install
Polaris on a workstation, you specify the application server name and datalink name for
the workstation. See Installing the Polaris Clients.

Polaris Authentication
Polaris authentication requires either Active Directory or Windows Workgroups. In an
Active Directory environment, the user is authenticated to the domain at logon.
Note:
Innovative does not support or test Polaris integration with other directory
systems such as Novell. Selection, implementation, and maintenance of
these systems is solely the library’s responsibility.
After Polaris is installed, you can set a staff client workstation for automatic logon to
the Polaris staff client using Windows Active Directory integrated security. When the
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Polaris staff client application is started, the logon dialog is skipped, and if the branchlevel Logon branch: Access permission is set for the workstation, the user can select a
logon branch. If the permission is not set, the workstation is automatically logged on to
the workstation’s parent branch. In Polaris Administration, set the Staff Client profile
Automatic logon to Yes to enable this feature. The profile is available at the system,
library, branch, and workstation levels; the default setting is No. For more information
about Polaris Administration, see the Polaris staff client help.
We strongly recommend Active Directory for all customers. However, if you do use
Windows Workgroups, the following configurations are possible:
l

Production server is in Active Directory environment, clients are in Workgroup.
There are two options:

l

o

The user must have a local matching account with the same password.

o

The user uses local workstation manage-network passwords, and uses an
account that will also be used to log into the Polaris client. The account must
also exist in the Active Directory domain where the Polaris production server
resides.

Production server is in Workgroup, client is in Workgroup.
There are two options:

l

o

The user must have a local matching account with the same password.

o

The user uses local workstation manage-network passwords, and uses an
account that will also be used to log into the Polaris client. The account must
also exist locally on the production server.

Production server is in Workgroup, client is in Active Directory domain.
There are two options:

l

o

The user must have a local matching account with the same password.

o

The user uses local workstation manage-network passwords and uses an
account that will also be used to log into the Polaris client. The account must
also exist locally on the production server.

Production server resides in one domain, clients reside in another domain and
there is no trust.
There are three options:
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o

The user must have a local matching account with the same password.

o

The user uses local workstation manage-network passwords, and uses an
account that will also be used to log into the Polaris client. The account must
also exist in the domain where the Polaris production server resides.

o

Install a Polaris Application Server in the same domain as the clients and
point the clients to this application server. The application server itself will
only use a SQL connection to the untrusted domain.

If you use any of these configurations, during Polaris client installation, you must select
Enable Workgroup Mode on the Server Information screen of the client installation
wizard and specify the authenticating domain for the production server. See Install
Polaris client software manually.
Staff Client Logon and Logoff Transactions
Polaris includes transaction logging for staff client logon and logoff transactions. You
can track currently logged-on users when performing upgrades, and generate reports of
historical usage of the software by user and/or workstation to assess staff client use.
The Polaris Workstations table records whether a workstation is logged on to the
Polaris staff client, and includes the server date and time of the logon. The following
transactions are posted in the Transactions database and are available for reporting:
Log-On (status = 1)
l

Transaction TypeID = TR_SYS_LOGON (7200)

l

OrganizationID - User’s log-on branch

l

Workstation ID

l

User ID

l

Transaction Client Date/Time

l

Transaction SubtypeID = SUBSYSTEM_TYPE (235)

l

Transaction SubtypeCode = Staff Client (33)

Log-Off (status = 0)
l

Transaction TypeID = TR_SYS_LOGOFF (7201)

l

OrganizationID - User’s log-on branch

l

Workstation ID

l

User ID

l

Transaction Client Date/Time
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l

Transaction SubtypeID = SUBSYSTEM_TYPE (235)

l

Transaction SubtypeCode = Staff Client (33)

Logoff transactions include any way in which the user exits from the client, including but
not limited to:
l

Shortcut Bar - Select X

l

Shortcut Bar - Select File > Exit

l

Shortcut Bar - Select File > Logoff

l

Shortcut Bar - Press ALT + F4

l

Workform - Select File > Exit

Licenses
Certain Polaris features and products are available by separate licenses. After
installation, contact your Polaris Site Manager to obtain your licenses. You can then
place them on your Polaris application server (see Place Polaris licenses on your
application server).
In Polaris 7.2, the following features require licenses:
l

3M (cloudLibrary) eBook Integration

l

Acquisitions EDI

l

Address Verification

l

Axis 360 eBook Integration

l

Borrow by Mail

l

Campaigns (automatic promotions)

l

Carousel Toolkit

l

Children's PAC

l

ChiliFresh Connections

l

ChiliFresh Ratings and Reviews

l

Community Profiles

l

ContentXChange

l

Course Reserves

l

Credit Card Payment - EnvisionWare

l

Credit Card Payment - SmartPAY
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l

Database Sync Restore

l

Driver’s License Scan Facility

l

Export Express (separately licensed option in SimplyReports)

l

ExpressCheck

l

ExpressCheck Credit Card Payments

l

Feature It! (Promotions)

l

Fusion

l

Inbound Telephony (Polaris Phone Attendant)

l

INN-Reach Integration

l

ITG DiscXpress

l

LEAP

l

Mobile PAC

l

Mobile PAC Credit Card Payments

l

Outbound Telephony (telephone notification)

l

Outreach Services

l

Overdrive eBook Integration

l

Polaris API Service (public) (PAPI)

l

Polaris Inventory Manager (PIM)

l

PowerPAC

l

PowerPAC credit card payments

l

RBdigital

l

RFID

l

SimplyReports

l

Staff Client Credit Card Payments

l

Titles to Go

l

URL Detective

l

Vega Discover

l

Wireless Access Manager (WAM)
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Server Installation and Upgrades
Innovative Interfaces stages servers and performs upgrades for Polaris customers. This
unit is for those customers who prefer to perform these procedures themselves. If you
are a new customer, you can contact your Polaris Implementation Project Manager at
any time for assistance. Existing customers can contact their Polaris Site Manager.
This unit covers the following topics:
l

Staging a New Polaris Server

l

Installing Polaris Server Software

l

Licensing, Logon Validation, and Diagnostics

l

Setting Date and Currency Formats

l

Changing the Polaris SQL User Password

l

Upgrading to Polaris 7.2

Staging a New Polaris Server
Polaris server software includes the application server, SQL (database) server, Polaris
Telephony, SimplyReports, Polaris Fusion, and web server components such as
PowerPAC (see Web Server Component Features for details). The Polaris server
applications are usually installed on several physical computers. This section
summarizes how to stage a new server, whether that server computer will house one or
several of the Polaris server software components.
Important:
For new installations, you must install Polaris Telephony on a new server
separate from the Polaris production server. If you are already running
Polaris Telephony, you will need a separate server for telephony when you
replace your servers. This configuration eliminates the problem of system
downtime when telephony services must be rebooted, and minimizes
issues with Dialogic driver compatibility.
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Stage a new Polaris server
For best results, use the Administrator account rather than an account with
administrator privileges to do these procedures.
Note:
If you need detailed procedures for staging a new server or installing and
using Microsoft Windows software, consult your Microsoft
documentation and/or contact Polaris Customer Support. Support
technicians can help with your specific situation.
1. Set up the RAID configuration according to your contract specifications. For more
information, contact your Polaris Site Manager.
Note:
Review all licensing issues and requirements whenever you install
any Microsoft products.
2. Install the following Microsoft server software on the appropriate servers:
l

All servers - Microsoft Windows Server 2012 R2, Microsoft Windows Server
2016, or Microsoft Windows Server 2019.
Important:
After you install the operating system software, view Windows
Updates to check for updates and security patches. (For
Microsoft Windows Server 2012 R2, right-click the Start button
and select Control Panel > System and Security > Windows
Updates. For Microsoft Windows Server 2016 or 2019, rightclick the Start button and select Settings > Update and
Security.) Install all critical or recommended Microsoft
Windows updates.

l

Application server - All Polaris servers require the Polaris Application Server
feature, which depends on Microsoft Message Queuing (MSMQ) being
installed. Message Queuing can be installed under the Features section of
the server features list in Server Manager.

l

Web server - Microsoft Internet Information Services (IIS) and Microsoft
Edge.
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Note:
SMTP is optional. If SMTP is selected, the prerequisite IIS 6.0
Manager will also be installed. The full IIS role (with web and
other features) is not necessary for SMTP to be installed.
3. Create a PolarisServices account on the domain and give the account appropriate
rights. The PolarisServices account must be a domain account.
Note:
If this is a workgroup Polaris application server, create the
PolarisServices account locally in computer management.
See Create a PolarisServices account and Give appropriate local security policy
rights.
4. Open Disk Management and set up any drives related to SQL Server to be
formatted with 64K cluster size. It is highly recommended that you configure
separate drives for DATA (SQL .mdf file type), LOG (SQL .ldf file type), and
TEMPDB.
If this is not feasible, the following list ranks disk management configurations
from best performance to worst performance:
l

Four separate drives (C: for OS, D: for DATA, E: for LOG, and F: for TEMPDB)

l

Three separate drives (C: for OS, D: for DATA and LOG, and E: for TEMPDB)

l

Two separate drives (C: for OS and TEMPDB, and D: for DATA and LOG)

l

One drive (C: for OS, DATA, LOG, and TEMPDB)

5. Move the databases from the old server to the new location.
6. Install SQL Server 2012 64-bit, SQL Server 2014 64-bit, SQL Server 2016 64-bit, or
SQL Server 2019.
Important:
If you plan to have both a production and training server, SQL Server
will need to be installed individually on each server. You cannot mix
a training database and a production database on one server.
7. Create an account for support purposes. In this guide, we assume that the account
is called PolarisExec. See Create a PolarisExec account.
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8. Configure DCOM or COM+ on all servers that will have the Polaris Application
Server feature installed.
9. Optimize Windows server software throughput for use with Polaris.
For example, navigate to System Properties > Advanced and select the Settings
button for Performance. On the Visual Effects tab, select Adjust for best
performance. On the Advanced tab, select Background services to optimize for
best performance of background tasks.
10. Enable network communication and access on all Polaris servers.
11. Install Polaris 7.2 server software and then reboot the server. See Installing Polaris
Server Software.
Important:
Do not install any Polaris server software on the domain controller.
13. Set up the client computers. See Client Installation.
14. Contact your Polaris Site Manager for any necessary licenses. See Licenses.
Create a PolarisServices account
The PolarisServices account runs Polaris services such as the ERMS daemon and the
business object under COM+. Unless the Polaris software is running in workgroup mode,
a domain account that will run the Polaris-related services will need to be created.
l

This account should not have administrator rights on the domain nor local
administrator rights on the Polaris servers from which it is used. This account
should have domain user rights only.

l

If security concerns are paramount about this account, you can create a group
policy (GPO) that limits this account to logging on only on the appropriate Polaris
servers.

l

Create a strong password for this account, at least 8 characters consisting of
letters, numbers and symbols.

l

You can change the password of this account, but you must update all services
that depend on this account with the new password.

As an example in the procedure below, the account is called PolarisServices. However,
you can create the account with any name you wish as long as its only use is for Polaris
services and the account is a non-administrator account. Ask your domain
administrator or Polaris Support personnel to create this account in Active Directory.
© 2022 Innovative (Part of Clarivate)
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Note:
Record your password for the PolarisServices account. You need the
<domain or machine>\username (for example,
MyDomain\PolarisServices) and the password during Polaris server
software installation.
(Workgroup mode only) Follow these steps to create a PolarisServices account on the
local machine for application servers that are running in workgroup mode:
1. On the local machine (application, Web, or DB server), select Control Panel >
Administrative Tools > Computer Management.
The Computer Management window appears.
2. Open the Users folder in the Local Users and Group folder.
The contents of the Users folder appear in the left pane.
3. Select Action > New User.
The New User dialog appears.
4. Type PolarisServices in the User Name box. Filling in the Full Name and
Description boxes is optional.
5. Type a Password.
Note:
Passwords are case-sensitive.
6. Confirm your password.
7. Clear the User must change password at next logon checkbox.
8. Select the following options:
l

User cannot change password

l

Password never expires

9. Select Create.
The New User dialog appears.
10. Select Close.
The Computer Management window appears.
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Give appropriate local security policy rights
Your PolarisServices account must have the following local security policy rights:
l

Act as part of the operating system

l

Log on as batch job

l

Log on as a service

l

Impersonate a client after authentication

l

Replace a process level token

In addition, the account that is used for the SQL Server Service account should have the
local security policy right Perform volume maintenance tasks. This increases
SQL Server performance when expanding its data files.
Follow these steps to assign security policy rights to the PolarisServices account.
(Follow a similar procedure to assign the Perform volume maintenance tasks right to
the account that is used for the SQL Server Service account.)
1. Select Control Panel > Programs > Administrative Tools > Local Security Policy.
The Local Security Settings dialog appears.
2. Open Local Policies.
3. Open User Rights Assignment.
The policy settings are displayed.
4. Select Act as part of the operating system > Action > Security.
The Local Security Policy Setting dialog appears.
5. Select Add to add the PolarisServices account to the list of groups with the right to
act as part of the operating system.
A list of accounts appears.
6. Select PolarisServices, and select Add.
The PolarisServices path name appears in the lower pane.
7. Select OK to confirm your selection.
The Local Security Policy Setting dialog appears. The Local
Machine\PolarisServices path name should be listed in the Assigned To pane. If
this account is a domain account, the path name is domain\PolarisServices.
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8. Select OK to confirm the setting.
The Local Security Settings dialog appears.
9. Repeat steps 4 through 8 to assign the following rights:
l

Log on as batch job

l

Log on as a service

l

Impersonate a client after authentication

l

Replace a process level token

l

Perform volume maintenance tasks . If you are installing SQL Server 2016 or
SQL Server 2019, skip this step. Instead, grant the right by selecting the box
in the SQL Server installation.
Note:
Give the same account that SQL Server is using rights to Perform
volume maintenance tasks.

10. Close the Local Security Settings window.
11. Restart the computer to activate the new PolarisServices account rights.

Related Information
Domain\PolarisServices needs full permissions to the following folders:
l

C:\Program Files (x86)\Polaris

l

C:\ProgramData\Polaris

Create a PolarisExec account
The PolarisExec account is used primarily by Polaris Support. This account must be a
domain account that has local administrative rights for Polaris servers only.
Note:
When you create your password for the domain account, contact your
Polaris Site Manager to supply the password for support purposes.
PolarisExec should be a domain account and thus created by your domain
administrator.
(Workgroup mode only) You can follow these steps to create a PolarisExec account
locally on the Polaris-related servers that are running in workgroup mode:
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1. On the server that is in workgroup mode for use with Polaris, select Control Panel
> Administrative Tools > Computer Management.
The Computer Management window appears.
2. Open the Users folder in the Local Users and Group folder.
The contents of the Users folder appear in the left pane.
3. Select Action > New User.
The New User dialog appears.
4. Type PolarisExec in the User Name box. Filling in the Full Name and Description
boxes is optional.
5. Type a Password.
Note:
Passwords are case-sensitive.
6. Confirm your password.
7. Clear the User must change password at next logon checkbox.
8. Select one of the following options:
l

User cannot change password

l

Password never expires

9. Select Create.
The New User dialog appears.
10. Select Close.
Verify PolarisExec in Local Machine Admin Group
Follow these steps to verify that PolarisExec is a member of the Local Administrators
group for servers running Polaris.
1. On the Polaris server, select Control Panel > Administrative Tools > Computer
Management.
The Computer Management window appears.
2. Open Groups in the Local Users and Groups list.
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The Groups list appears in the right pane.
3. Double-click Administrators.
4. Select the Member Of tab.
The users who are part of the Administrators group are listed.
5. If PolarisExec is not listed, use the following steps to add it to the group:
l

Select Add.

l

Type PolarisExec, and select Add.

l

Select OK to save the information.

6. Select X to close the Computer Management Window.

Installing Polaris Server Software
When you install Polaris server software, you can choose which components to install
on that particular server computer. You can install the following components on one
server computer, or separate computers:
l

Application Server

l

Web Server (PowerPAC Server) - See Web Server Component Features for details.

l

Database Server

l

ERMS (Electronic Resource Management System) Server

l

Reporting Services

l

Polaris Phone Notification (outbound telephony)

l

Polaris Phone Attendant (inbound telephony)
Important:
--Do not install any Polaris server software on the domain controller.
--Telephony applications require a separate server.

Before you install the Polaris server software, you must prepare each server computer
by installing the appropriate Windows operating software, including SQL Server (new
installations), MSMQ (new installations, application server only) and the Polaris
Windows Components Updates (new installations and updates). See Staging a New
Polaris Server.
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Web Server Component Features
The following features are available for Web Server installation.

Robots.txt - Limiting Web Crawlers
Robots.txt is an optional file that limits the ability of web search engines to “crawl” your
Polaris PowerPAC pages. These automatic searches can register misleading
transaction statistics and may impact performance. The Robots.txt file is always
installed in the IIS root folder: [WindowsVolume]Inetpub\wwwroot\
The default version of Robots.txt allows only your portal page to be searched
automatically by web crawlers. You can edit the file to allow other pages to be searched.
If you edit Robots.txt and later reinstall Polaris server software, the existing file is
backed up with the Polaris version added to the end of the file name, for example
Robots.txt.5.6.270, so that your changes are preserved.
Note:
The Polaris Server installation will create only one backup of Robots.txt
per release build. If you install the same build of Polaris more than once,
Robots.txt is backed up the first time only.

Polaris Ancillary Web Service (PAWS)
PAWS is a web service used by Polaris Inventory Manager, Polaris Telephony Voice
Recorder, and other applications.

PAPI Service
The Polaris Application Programming Interface (PAPI) is a web-based REST service
which returns data from and/or performs actions in the Polaris application database.
Method calls are made over TCP connections by sending HTTP GET, PUT, POST and
DELETE requests; method calls are also made over NCIP, SIP, and Z39.50 connections.
Nearly any computer language can be used to communicate over HTTP with the REST
server. Returns are made as XML and JSON. The Polaris Developer Network is available
to Polaris API license holders, with a “sandbox” version available to any Polaris
customer who requests access (customers do not need a Polaris API license). The
Network offers forums, API documentation, sandbox servers, test tools, sample code,
and downloads, eliminating the need for a training server to test custom solutions that
use the Polaris API. For more information, go to
http://developer.polarislibrary.com.
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Swagger is an open-source framework for REST APIs. In Polaris 5.2 and later versions,
PAPI has a Swagger endpoint which provides code and documentation to Polaris
customers and third-party vendors who use the Polaris API. For more information about
Swagger, go to http://swagger.io/. A Polaris Web Server installation option provides
access to the Polaris Swagger endpoint.

Mobile PAC
Polaris® Mobile PAC™ is a web-based public access library catalog that has been
optimized for mobile devices. It provides simplified access to most of the features that
are available in Polaris® PowerPAC™. Any device with a web browser can access the
site, including mobile devices with browsers optimized for mobile use and desktop
machines with standard web browsers. Polaris Mobile PAC is a separately licensed
product. For more information, see the Polaris staff client help.
Note:
In Polaris 7.2, Polaris PowerPAC is responsive to the user's device, and
automatically adjusts to desktop, tablet, and smartphone displays.

Fusion Provider
With the Polaris® Fusion™ digital collection management system, libraries can expose,
maintain, and manage digital collections. You can use Polaris Fusion to attach multiple
digital files (such as images, audio files, video files or pdfs) to MARC records within the
Polaris database, and expose this digital content to patrons through Polaris PowerPAC
and Mobile PAC. You can also maintain and control access to a private repository of
restricted digital media and offer this media to patrons for a fee. If you accept credit
card payments for fines and fees in PAC, you can accept payments for digital
downloads. For more information, see the Polaris Fusion Guide.

ContentXChange
Libraries that use Polaris Community Profiles can offer their community partners
ContentXChange, available under separate license. ContentXChange consists of a set of
widgets that provide an easy way to incorporate features from the library or the
organization’s library record into the organization’s own website. For more information,
see the Polaris staff client help.
Important:
If you install ContentXChange, you must set the PAC parameter URL of
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the ContentXChange/Carousel Toolkit root for the Web server in Polaris
Administration.

Polaris Language Editor (WebAdmin)
Polaris Language Editor is a web-based tool for customizing English and other licensed
language strings in all the parts of Polaris that support multiple languages, including
Polaris PowerPAC, Polaris ExpressCheck, printed and email notices, telephone notices,
text message notices, Polaris Phone Attendant (inbound telephony), Mobile PAC, and
Polaris Fusion. Polaris Language Editor also provides special PAC tools, including a
language string identifier for Polaris PowerPAC and the reload tool to clear the Polaris
PowerPAC or Mobile PAC cache and reload PAC pages.
WebAdmin is automatically installed when you install Polaris Web Server software. The
server must be registered as a workstation in Polaris Administration, and both the
workstation and staff user must have the system-level System Administration
WebAdmin access: Allow permission. The staff member must log in with Polaris
username, password, and domain name. For more information about registering
workstations in Polaris and setting Polaris permissions, see the Polaris staff client help.
For more information about using Polaris Language Editor, see the Polaris Language
Editor (WebAdmin) Guide, available from the Language Editor Help tab.

SimplyReports
With Polaris® SimplyReports, users who do not have in-depth knowledge of the Polaris
database or expertise in Structured Query Language (SQL) can produce thousands of
different kinds of reports by selecting the data columns, filters, and other options on a
simple web-based interface. Once you have defined the criteria for the report, you can
save the report parameters and schedule the report to run at another time, or you can
create the report immediately. In addition, if your library has purchased Polaris Export
Express, you can save the report output for item, bibliographic, and authority list reports
in a variety of exportable file formats. For more information, see the SimplyReports help.

PowerPAC
Polaris PowerPAC is your web-based public access catalog. If you have a license for
Polaris PowerPAC Children’s Edition, it is installed with PowerPAC. For more
information about both applications, see the Polaris staff client help.
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INN-Reach
INN-Reach integrates consortial Polaris and Sierra library catalogs with a shared INNReach Central Catalog that enables patrons to easily find and request materials online.
The INN-Reach Central server is hosted in AWS (Amazon Web Services). See Installing
INN-Reach.
Automatic Reindexing at Server Upgrade
In Polaris Administration, libraries can set the system-level Cataloging parameter MARC
Re-index during next server upgrade to Yes to trigger automatic reindexing at no cost
when they upgrade to Polaris 7.2. You will see no change in your previous version of
Polaris, although you must set the parameter in the previous version, before you
upgrade to Polaris 7.2. When the upgrade to Polaris 7.2 and the reindexing are
complete, the parameter is automatically reset to No (the default setting).
Important:
Reindexing can add a significant amount of time to the upgrade process
and should be avoided if it is not necessary. However, if you must reindex,
performing the process at upgrade may be both cost-effective and timeeffective, since there is a fee associated with retroactive reindexing and
the server will be offline during the upgrade in any case.
When the parameter is set to Yes, the system sets a flag so that the server installation
database update (DBUpdate) process performs a reindex comprised of the following
general steps:
l

Alerts the Polaris support engineer that a reindex will take place during the
DBUpdate process

l

Rebuilds indices and relinks bibs to authorities

l

Defragments database tables

l

Updates database statistics

When the reindexing has successfully completed, an alert is logged in the DBUpdate
report.
To set the parameter in your previous version of Polaris (anticipating an upgrade to the
next release), you need the System Administration permission Access MARC Re-index
during next server upgrade: Allow to set the parameter. When the parameter is changed
from No to Yes, you also receive a warning message regarding potential upgrade time.
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Install Polaris Server Software
Follow these steps to install the Polaris server software.
Note:
If your site has a two-server configuration (separate web server), see the
specific instructions in Install server software (separate web server).
1. Install the prerequisites from the Polaris server install, if you have not already done
so.

Note:
The server will restart if any prerequisites require it. If this occurs,
the installation process will resume after the server restarts.
Once the prerequisites are installed, a welcome dialog appears.
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2. Select Next.
The License Agreement dialog appears.
3. Select I accept the terms in the license agreement.
4. Select Next.
The Customer Information dialog appears.
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5. Type your username and organization name in the appropriate boxes.
6. Select a user permission option using the Install this application for setting.
7. Select Next.
The Polaris Server Information dialog appears.
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8. Type the appropriate computer names in the Server Name boxes.
Note:
Your Polaris server configuration determines the server names you
supply in this dialog. For example, if the application server, the SQL
server, and the web server reside on the same physical computer,
type the same name in all three boxes.
9. If more than one SQL instance exists on your SQL server, select the Enable SQL
Instance checkbox, and type the instance name in the box next to the option.
Example:
You may have separate SQL instances set up if there is more than
one Polaris database. If you have separate SQL instances, you need
to check this option and supply the instance name for database
updates.
10. Select Next.
The Custom Setup dialog appears.

11. Select or deselect the server software to install on this computer by selecting a
server name and selecting an option from the drop-down menu. For more
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information about web server components, see Web Server Component Features.

Example:
If you do not want to install Web Server software on this computer,
select Web Server, and select This feature will not be available
from the drop-down menu.
Notes:
l

If you are installing Polaris Fusion Provider on a dedicated
server, you must also install the Application Server and ERMS
Server components. Open the same ports as you do for the
Web Server.

l

If you select Database Server for installation, be aware that
the database update can take an hour or more to complete. If
this installation is an upgrade from a previous version of
Polaris, and you have set the Polaris profile to reindex the
database at upgrade, the reindexing takes place immediately
after the database update. This process can take from 30
minutes to 7 hours. See Automatic Reindexing at Server
Upgrade for more information.

l

Polaris System Administration (web-based) requires OAuth 2.0
and Active Directory Federation Services (AD FS) to
authenticate users. If you select Polaris Administration to
install this software, your library must set up OAuth and AD FS.
For more information, see the Polaris OAuth 2.0 Integration
with Microsoft AD FS Guide.

12. (Optional) If you want to install the Polaris servers in a folder other than the default
location, select Change to display the Change Current Destination Folder dialog.
Specify or select the folder where you want to install the server software, and
select OK to return to the Custom Setup dialog.
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Tip:
To accept <SYSTEMDRIVE>\Program Files\Polaris\7.2 as the
default location, skip this step.
13. If the ERMS Port Configuration dialog appears, change the default listening ports if
necessary.
The ERMS Daemon is a service that provides storage, processing, and access to
electronic resources.
The example screen below shows the default ports that are used by the ERMS
Daemon. Do not modify the port settings unless you have a specific technical need
to use another port. If you will not be using the default ports, please confer with
your site manager to discuss other changes that might be necessary to make your
configuration work. Note that the HTTPS port can be disabled, but Innovative
highly recommends that you leave it enabled.

14. Select Next.
The Polaris Services User Account Information dialog appears.
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Note:
The Polaris Services account must be a standard user account (nonadministrator privileges) and must not belong to the administrators
group. See Create a PolarisServices account and Give appropriate
local security policy rights.
15. Type the Polaris Services username in the format Domain\PolarisServices.
16. Type the Polaris Services password in the Password box.
17. Type the Polaris Services password again in the Verify Password box.
18. Select Next.
19. If the Report Server dialog appears, type the complete URL for the Report Services
Server on this computer, type the Report Services Server Root.
The Report Server dialog appears if you are installing Reporting Services on this
computer. Reporting Services is selected for installation by default.

© 2022 Innovative (Part of Clarivate)
Page 31

Polaris Installation Guide

Note:
Reporting Services files are typically installed on the web server, but
they can be configured as an independent server.
20. Select Next.
If you selected Database Server for installation in step 11, the Polaris
SQL Password dialog appears. Continue to the next step.
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If you did not select Database Server for installation, the Ready to Install the
Program dialog appears. Skip to step 23.
21. (Optional) If you want to change the Polaris SQL password, select Change Polaris
SQL Password and type the new password in the Password box.
Note:
The maximum length of the password is 50 characters. The
password characters are not visible when you type in the Password
box.
22. Select Next.
The Ready to Install the Program dialog appears.
23. Select Install.
The Installing Polaris Server 7.2 dialog is displayed until the installation is finished.
Important:
Before doing the next step, make sure the database update (DB
Update Scripts) has finished. This process can take an hour or more
to complete. When the update is complete you are notified by a text
file.
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24. Select Finish.
25. Restart the computer.

Related Information
Web server access for Reporting Services - Polaris uses SQL Server Reporting Services
for reports, notices, and most printing tasks in the staff client. Microsoft Report
Manager (and Report Designer, if you customize reports) is installed on your report
“server,” which may be located on your Polaris web server or another server you specify.
For more information, see Reports.
Activating Polaris PowerPAC Multilingual Version or Mobile PAC - Contact your Polaris
Site Manager. For more information about setting up Polaris PowerPAC Multilingual
Version and Mobile PAC, see the Polaris staff client help.
Activating Polaris PowerPAC Children’s Edition - Contact your Polaris Site Manager.
Then, using SQL, insert attribute ID 1966 in the Polaris organizationspppp table:
insert organizationspppp
values (1, 1966, ‘yes’)
In Polaris Administration, set the PowerPAC profile Navigation: Children’s PAC to Yes
to display the link on the Polaris PowerPAC page. For more information about setting up
Polaris PowerPAC Children’s Edition, see the Polaris staff client help.
Install server software (separate web server)
Follow these steps to install Polaris server software if you have a two-computer server
configuration with a separate web server. In this configuration, the Application Server
and Database Server components are installed on one computer, and the selected Web
Server components, ERMS Server, and Reporting Services components are installed on
the other.
Note:
Telephony applications require a separate server. Install telephony
components on the telephony server.
1. Follow the general instructions for installing Polaris server software until the
Polaris Server Information dialog appears. See Install Polaris Server Software.
2. When the Server Information dialog appears, supply the server names in the
appropriate boxes:
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l

Type the name of the application server computer in every Server Name box
except Web Server Name.

l

Type the name of the web server in the Web Server Name box.

In the example below, the application server is called Server1. The web server is
called Server2.

3. If more than one SQL instance exists on your SQL server, select the Enable SQL
Instance checkbox, and type the instance name in the box next to the option.
4. Select Next.
The Custom Setup dialog appears.
5. De-select every feature for installation except Application Server and Database
Server.
6. Select Next and complete the installation on this computer. See Install Polaris
Server Software for details.
7. On the Web server computer, start the Polaris server installation.
8. When the Polaris Server Information dialog appears, supply the server names in
the appropriate boxes:
l

Type the web server name in the Application Server Name and the Web
Server Name boxes.
© 2022 Innovative (Part of Clarivate)
Page 35

Polaris Installation Guide

l

Type the name of the SQL server in the SQL Server Name box.
Note:
If the web server is outside a firewall, the Application Server Name
and Web Server Name fields would use the same value. This is
because outside a firewall, the application server components must
be running locally to the web server. If the web server is on the same
network as the application server, the web server and application
server can be separate servers. In this case, you will still use
Computer1 for the Application Server Name even though Computer2
is the Web Server Name.

9. Select Next.
The Custom Setup dialog appears.
10. Select Web Server component features, ERMS Server, and Reporting Services for
installation. For more information about web server components, see Web Server
Component Features.
11. Select Next and complete the installation on the web server. See Install Polaris
Server Software for details.

Related Information
l

Two-server configuration in Polaris Administration - In Polaris Administration, the
application server should have an SQL connection and a Z39.50 connection. The
web server should have only a web connection. For more information about
configuring servers in Polaris Administration, see the Polaris staff client help.

l

Web server parameters - In Polaris Administration, check the parameters for the
web server to be sure they refer to the web server. For more information about
setting server parameters in Polaris Administration, see the Polaris staff client
help.

Installing INN-Reach
For an overview of INN-Reach integration, see INN-Reach and also see the Polaris staff
client help. Two server software components are installed as part of the Polaris INNReach integration:
l

Windows service process (Polaris INN-Reach Connector) which continually sends
real-time record updates of bibliographic and item data to the INN-Reach Central
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server, as well as outgoing API messages related to INN-Reach circulation and
request functions.
l

INN-Reach Web service which listens for incoming API messages related to
request and circulation messages from the INN-Reach Central server and other
local servers that are members of the consortium. This also serves as a
management portal for configuration and monitoring.

For the the local Polaris server running INN-Reach processes, all inbound and outbound
traffic on port 443 (including appropriate SSL certificates) to the following INN-Reach
Central servers in AWS (Amazon Web Services) should be allowed:
l

54.183.40.224

l

54.67.111.221

Inform your Innovative customer support representative of the IP and domain name of
the local Polaris server that will be connecting to AWS. The support representative
should communicate this information to Innovaive staff responsible for the Innovative
AWS platform.
To configure INN-Reach for your local Polaris system, you work with your Innovative
customer support representative to complete a spreadsheet of configuration data. Your
support representative then uses a configuration utility, InnReachConfig.exe, to load the
configuration.
Follow these steps to install and verify Polaris INN-Reach server software:
1. Follow the general instructions for installing Polaris server software, selecting
INN-Reach (under Web Server) for installation. See Install Polaris Server Software.
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2. License the server for INN-Reach Integration. See Place Polaris licenses on your
application server.
3. Verify that the INN-Reach Admin Portal is installed on the server.

4. Verify that the INN-Reach Windows Service is installed.
5. Check log files in C:\ProgramData\Polaris\7.2\Logs\InnReach.Connector\ for
status of running INN-Reach service. Since configuration data has not yet been
loaded, the log should say that the process exited.
6. Have your Innovative customer support representative run the configuration utility,
InnReachConfig.exe, to load your configuration data.
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7. Once the configuration has been successfully loaded, view the configuration in the
INN-Reach Admin view.
Note:
You need the Polaris permission INN-Reach Administration: Access
to view the INN-Reach Administration tool. You need both INNReach Administration: Access and INN-Reach Administration:
Modify permissions to make changes.

Licensing, Logon Validation, and Diagnostics
The Polaris server application offers useful features under the Polaris Tools program
entry in the Start menu:
l

Polaris Licensing Wizard - Place Polaris licenses on your application server

l

Validate Polaris Logon and Licensing - Validate Polaris Logon and Licensing

l

View Polaris Diagnostic Messages - View Polaris diagnostic messages

The example below shows Windows Server 2012 R2:

This example shows Windows Server 2016:
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Place Polaris licenses on your application server
Once Innovative has made the appropriate licenses available to your site, you can use
the Polaris Licensing Wizard tool to place the licenses on your application server. Follow
these steps.
Note:
This procedure requires your Polaris site code and passphrase. Contact
your Polaris Site Manager to obtain this information if necessary.
1. On the Start menu, select Polaris > Tools > Polaris Licensing Wizard.
The Welcome window appears.
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2. Select Next.
The Application Server window appears.
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3. Select your application server, type your Polaris account logon information, and
select Next.
The Machine Identifier window appears.

4. Leave the Machine Identifier settings as they are, and select Next.
The Register Application Server window appears.

5. Enter your Polaris site code.
Note:
Contact your Polaris Site Manager to obtain this information if
necessary.
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6. Select one of the following options:
l

First-time users - Select Register application and create license file. Then
type and confirm your passphrase.
Note:
Contact your Polaris Site Manager to obtain this information if
necessary.

l

Updates - Select Update current license file.

7. Select Next.
The Generate Script window appears.

8. Select one of the following options:
l

Application server with Internet access - Select Execute immediately. This
option will automatically generate the license file and place it on your server.

l

Application server with no Internet access - Select Generate license request
script and specify a script file name. If you select this option, send your
script file to your Polaris Site Manager so that Innovative can register your
license. Innovative will send the license file back to you.
Note:
You may need to change your script file extension to .txt in
order to email it to your Polaris Site Manager.
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9. Select Next.
The Complete the Wizard window appears.

10. Verify your choices and select Finish (or select Back to change your settings).
The status window appears.

11. Select Close.
If you chose to generate and receive your license file directly via the Internet, the
license file is automatically created and placed in the Polaris directory. If you
chose to generate the script and send it to Innovative by email, Innovative
generates the license file and sends it back to you. Place the file in the appropriate
location, typically:
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C:\Program Files (x86)\Polaris\7.2\bin

Validate Polaris Logon and Licensing
Use this option to verify license information and test the logon without actually installing
the Polaris staff client application.
1. On the Start menu, select Polaris > Tools > Validate Polaris Logon and Licensing.
The Polaris Login dialog appears.

2. Supply the following information:
l

Server - Select your application server if necessary.

l

User name - Type the Polaris user name. The user name must be a user
registered in the Polaris database.

l

Password - Type the password associated with this user name.

l

Domain - Type the network domain.

l

Use Windows Authentication - Select if appropriate.

3. Select OK.
The Polaris Properties dialog appears. The illustration is an example of the type of
information the General tab displays. If the Site Code field is blank, there is no
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license file.

4. Select the Licenses tab to see your currently assigned licenses. The illustration is
an example where licenses have been assigned.
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5. Select OK to close the Properties dialog and exit the Validate Polaris Logon and
Licensing tool.
View Polaris diagnostic messages
Use this tool to access the Polaris Diagnostics node in the event log, without having to
open the Event Viewer and search for the node.
On the Start menu, select Polaris > Tools > View Polaris Diagnostic Messages. The
Event Viewer opens, and the Polaris Diagnostics log is automatically selected.
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Setting Date and Currency Formats
Polaris supports various date formats. Set your server and client computers to the date
format you prefer. For example, on a Windows 8 workstation, select Control Panel >
Clock > Language and Region, and select the format from the Region list.
Important:
Client and server date format settings must match.
Polaris also supports currency conversion in Acquisitions for libraries that use foreign
vendors. You must set your own base currency to use this feature, and your base
currency must be in dollar format (United States, Canada, Australia). On the Language,
Clock, and Region dialog, select Additional settings (Windows 8) to set a currency
format within the regional setting, then select Currency to display the Currency tabbed
page. You must keep the dollar sign on the left, and the decimal point before the last
two digits. For more information about currencies, see the Polaris staff client help.
Important:
Client and server currency format settings must match.
Ensuring Consistency in Locale and Time
Transaction time stamps are derived from both the server and the staff client. If the
time setting is different on these computers, you may notice discrepancies in logs and
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transactions. After the Polaris staff client is installed, using staff client profiles in Polaris
Administration, you can enable automatic checking for consistency in date and currency
formats, as well as the time recorded for logs and transactions. For more information,
see “Ensuring Locale and Time Consistency” in the Polaris staff client help.

Changing the Polaris SQL User Password
Best security practices dictate that you change the default Polaris SQL User password,
which controls access to your database. To change the password, you run a script in
SQL Management Studio, then update the password for Reporting Services. Follow the
steps outlined below, or contact your Polaris Site Manager for assistance.
Change the Polaris SQL user password
Follow these steps to change the default Polaris SQL User password.
1. Open SQL Management Studio as an administrative user.
2. Select the Polaris database.
3. Run the following script, where ‘PASSWORD’ is the new password for the polaris
SQL user:
ils_setpassword ‘PASSWORD’
A complex password consisting of letters, numbers, and symbols is
recommended. Certain symbols are not accepted: ~!%^&()-{}'.\`

4. When the script has run, reboot the server.
Update the password in Reporting Services
Because the polaris SQL user password is cached in Reporting Services, you must also
update the password there. Follow these steps to update the password in Reporting
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Services.
1. Open Report Manager at:
http://servername/reports
2. Select the Polaris data source.

3. Type the new Polaris SQL user password in the Password field.
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4. (Optional) Select Test Connection to test your change.
5. Select Apply.

Upgrading to Polaris 7.2
You can upgrade to Polaris 7.2 from Polaris version 5.0 (191) or later.
Important:
If you want to reindex your database automatically as part of the upgrade,
set the Cataloging parameter MARC Re-index during next server upgrade
to Yes. See Automatic Reindexing at Server Upgrade.
Note:
If you have a single-server production environment, see Servers ("RAM
Recommendations for Single-Server Environments").
To upgrade to Polaris 7.2 from a previous version:
1. If you plan to do the update while maintaining full library functions, create offline
transaction files.
2. Verify that all users are logged off the server, and close all staff and public clients.
3. Back up the Polaris database.
4. Uninstall the previous Polaris server and client software from the servers.
5. Apply all Microsoft and Microsoft Windows updates.
6. Install Polaris 7.2 server software. See Installing Polaris Server Software.
7. Install the Polaris staff and public client software on the appropriate workstation
computers. See Installing the Polaris Clients.
Important:
The installation terminates any running Polaris.exe processes
before the installation proceeds.
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Client Installation
The Polaris staff client (Polaris ILS), Polaris SIP (self-check), Polaris NCIP service, and
Polaris ExpressCheck use the same installation program. You choose which software to
install during client installation.
Note:
The client prerequisites are rolled into the client installation and will be
automatically installed, if necessary.
This unit covers the following topics:
l

Installing the Polaris Clients

l

Group Policy Deployment

l

System Center Deployment

l

Automating Polaris Client Deployment

l

RFID Circulation for Polaris Hosted and Terminal Server Environments

Installing the Polaris Clients
Along with staff client software, the client software required for computers controlling
SIP2 self-check, NCIP service, and Polaris ExpressCheck is included in the Polaris client
installation software. You can install any of these independently, without necessarily
installing the staff client.
Note:
Polaris client software can also be installed on Polaris servers as part of
the server installation process. See Installing Polaris Server Software. The
procedure is the same, except that you cannot change server names or
the installation path.
Client Installation Methods
Several options are available for installing Polaris client software. See the following
topics:
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l

Install Polaris client software manually

l

Group Policy Deployment

l

System Center Deployment

l

Automating Polaris Client Deployment

Printing Reports, Notices, and Purchase Orders
Staff computers that are used to print Polaris reports, notices, or purchase orders
require the following configuration:
l

The database containing the purchase orders to be printed must be named
Polaris.

l

At least one page-size printer must be set up in Microsoft Windows on the
computer.
Important:
Polaris requires Adobe Reader DC or later on any workstation that runs
reports, notices, or does certain staff client printing tasks. The application
is available at no cost from http://get.adobe.com/reader/

Security Manager
The Polaris Security Manager is automatically installed if you select RFID, EM
(electromagnetic), or AV Locker security options while installing Polaris ExpressCheck,
or RFID while installing the Polaris staff client. It supports the Polaris security interface
and provides the underlying implementation for each supported third-party security
model, including the following:
l

3M™ RFID

l

Bibliotheca RFID

l

EnvisionWare RFID

l

Bibliotheca SmartDispenser200™

l

Bibliotheca EM (electromagnetic security)

The Polaris client software communicates with the Security Manager using a common
interface, and the Security Manager handles the specific details of each RFID
implementation. Thus the Security Manager provides the ability to apply security fixes,
updates and upgrades by simply updating the Security Manager.
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The Security Manager provides tightly integrated security (RFID, AV, EM) operations,
allowing Polaris client software to communicate directly with each security device.
Polaris controls when to read from devices, when to write to devices, and so forth. The
Security Manager does not rely on screen scraping or a keyboard wedge to send key
operations. There is no need to manage a second application for security operations.
Settings in the Security Manager are vendor-specific, not Polaris client-specific, so any
changes you make in the Security Manager affect all the client workstations that use the
vendor’s security features.
Important:
The Security Manager uses TCP port 8075. This port must be open if any
security measures (RFID, EM, AV Locker) are used.
The Security Manager is set with the equipment manufacturer’s default values and the
security options that you select for your vendor when you install the Polaris client
software. If you need to change these settings, open SecurityManager.exe, located by
default on the client workstation at:
C:\Program Files\Polaris\7.2\Bin
This puts the Security Manager icon in the desktop tray. Select the icon to open the
Security Manager, and select your vendor.
Note:
You can install a standalone Security Manager for workstations without
the staff client that will run Leap with integrated RFID. See Integrated RFID
for Workstations Running Leap (No Staff Client).
Note:
Polaris supports integrated RFID on Polaris workstations using an RDP
connection to Terminal Server. See Security Manager and RFID in Hosted
and Terminal Server Environments.
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The available RFID options depend on the vendor. They are the same as those you can
select during client installation:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Dedupe item barcodes - Select this option if your library places RFID tags with
duplicate item barcodes on all items in a set. When this option is selected, at
check-out duplicate item barcodes are removed from the list of RFID tags currently
on the antenna pad (reader) so that the set is checked out once.

l

Patron tag supported - Select this option if your ITG installation supports patron
RFID tags.

l

Targeted security - This option, which is selected by default, provides the ability to
set RFID security to off for certain items in a stack of items. You can de-select this
option if your RFID vendor is ITG. If the option is not selected, RFID security is set
to off for the entire stack of items on the reader.

l

Tag format - For 3M RFID. Select 3M Numeric Item or 3M Alphanumeric Item.

If you run Polaris ExpressCheck on Bibliotheca hardware, you can also change settings
for the EM (electromagnetic) and the AV Locker security features:
l

EM Wait (milliseconds) - Sets the amount of time Polaris ExpressCheck pauses
while the EM device travels along the rails inside the unit.

l

AV Locker - When this option is enabled and an item is scanned, the material type
is checked in the SelfCheck Material Types policy table. If the Unlocker option is
set to Yes for the material type, an instruction screen explains how to unlock the
media locker. For more information about this feature, see the Polaris
ExpressCheck Administration Guide.
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o

Max Attempts - Specifies the number of intervals the software waits for the
user. If the user exceeds the maximum number of attempts, the item is not
checked out.

o

Wait (seconds) - Specifies how long the locker remains unlocked.

You can save a log file for RFID security debugging purposes. On the Log tabbed page,
select Save log to file. The log file is saved in the following location:
C:\ProgramData\Polaris\7.2\Logs\SECURITYMANAGER

Integrated RFID for Workstations Running Leap (No Staff Client)
Note:
For information about installing integrated RFID for Leap on workstations
where the Polaris staff client is also being installed, see Install Polaris
client software manually.
If a workstation will be running Leap with RFID without installing the Polaris staff client,
you can enable RFID by installing the standalone Security Manager. To install the
standalone Security Manager and enable RFID for Leap:
1. Run setup.exe in the Security Manager folder.
2. In the SecurityManager - Install Shield Wizard dialog, select Leap Integrated, and
select Next.
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3. Complete the Security Manager installation.
4. Open the Polaris Security Manager, and select the Setup tab.

5. Select the RFID vendor in the Vendor list.
6. If it is not already selected, select the Https Enabled checkbox.
7. Select the RFID checkbox and set the security options.
8. To ensure that Security Manager is installed and connecting correctly, you can test
the connection in Leap. Go to the Settings page in Leap, select the RFID tab, and
select TEST SECURITY MANAGER CONNECTION.
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Security Manager and RFID in Hosted and Terminal Server Environments
Polaris supports integrated RFID circulation on Polaris workstations that are used in a
hosted environment or otherwise use an RDP connection to Terminal Server. To use this
functionality, you perform a Polaris client installation on the Terminal Server, specifying
Terminal Server as the RFID “vendor,” and then install a standalone Polaris Security
Manager application on the RFID-enabled workstations that will communicate with the
Terminal Server. For details, see RFID Circulation for Polaris Hosted and Terminal Server
Environments.
Credit Card Reader
When staff members accept credit card payments through the Polaris staff client, they
can enter payment information manually or using a magnetic swipe credit card reader.
Polaris ExpressCheck requires a magnetic swipe credit card reader for payments. When
you install staff client or ExpressCheck client software on a workstation, be sure the
credit card reader is connected to the client workstation, and that one of the credit card
reader options is selected. See Install Polaris client software manually. If you use a
serial credit card reader, select Enable Serial Creditcard Reader during installation. If you
use a USB device, select Enable Keyboard Emulation Creditcard Reader during
installation. You can use any swipe reader that supports keyboard emulation and
returns the swipe data in ISO 7813 format followed by a CR.
Note:
The MagTek Mini Swipe credit card reader must be configured and
installed for keyboard emulation on 64-bit Windows workstations. It
cannot be installed as a serial credit card reader because the MagTek
Mini Swipe driver is not compatible with 64-bit versions of Windows.
Important:
If you are installing ExpressCheck with credit card support on a SeePoint
unit, select Enable Serial Creditcard Reader. If you are installing
ExpressCheck with credit card support on an NCR unit, select Enable
Keyboard Emulation Creditcard Reader.
Serial mode readers work only for clients that are directly connected to the Polaris
server. USB keyboard emulation readers work both for clients that are directly
connected, and for clients that connect to a Terminal Server.
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In serial mode, Polaris controls when the magnetic swipe reader will accept a card
swipe. In USB keyboard emulation mode, the magnetic swipe reader is not controlled
and accepts a card swipe at any time.
Innovative currently recommends the Magtek® Centurion magnetic swipe reader, part
number 21073062. This unit connects to the workstation via a USB Type A plug and
receives power from the USB bus. The unit has two programmable interface modes,
USB HID (Serial) and USB Keyboard Emulation, but is pre-programmed for USB Keyboard
Emulation mode. USB Keyboard Emulation mode works both for directly connected
clients and for clients in a Remote Desktop/Terminal Server environment. Serial mode
works only for directly connected clients.
Telephony Text-to-Speech (TTS) Editor
Polaris telephony includes the TTS Lexicon Editor that you can use to modify the
pronunciation of certain words, such as branch or place names, when message text is
converted to computer-generated SAPI (Speech Application Programming Interface)
voice messages. You select sounds for a word from a standard list of English
phonemes (speech sounds), and the pronunciation is stored in the SAPI Lexicon, a
database for the words and their pronunciations.
The TTS Lexicon Editor is included in the Polaris telephony server installation. However,
because each user log-on has its own Lexicon database, and because the workstation
needs a sound card to test pronunciation adjustments, you cannot use Remote Desktop
to connect to the telephony server and work with the Lexicon Editor there. You must log
on locally to a workstation with a sound card and speakers to test the pronunciation,
then use Remote Desktop to connect to the telephony server and copy your changes.
For the most accurate test, the workstation should have available the SAPI voice
actually used in the message. To make this process more convenient, you can select the
TTS Lexicon Editor as part of the staff client installation, then install the appropriate
AT&T SAPI voice on the workstation.
For detailed information about installing and using the TTS Lexicon Editor, see Polaris
staff client help.
Install Polaris client software manually
To install the Polaris 7.2 client software manually, the file Polaris Client Installer.exe
must be run on each client workstation. For convenience, during the Polaris server-side
installation, a share is created (using folder C:\Program Files\Polaris\7.2\Clients) that
contains Polaris Client Installer.exe so that the file can be readily available to client
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workstations. To access this file from a client workstation, navigate to
\\<servername>\clients\ where <servername> is the name of the Polaris Server on
which the share was created.
Note:
For other client installation methods, see the following topics: Group
Policy Deployment; System Center Deployment.
Follow these steps to install Polaris prerequisites and Polaris 7.2 client software
manually.
Important:
The installation terminates any running Polaris.exe processes before the
installation proceeds.
Note:
When a new Polaris release is installed on a workstation, the file path
changes only for a major release. For Service Pack (SP) installations, the
file path remains the same as for the major parent release.
1. Navigate to the share folder, and double-click Polaris Client Installer.exe.
The Polaris Client Installer wizard opens. The illustration shows an example.
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Note:
The requirements listed in the Polaris Client Installer dialog differ for each
computer because of operating system variations and software already
installed. The listed components are those that must be installed for
Polaris to install and function properly on this specific computer.
2. Select Next to install the required components and the client software.
Installing the Polaris prerequisites takes from no time at all to several minutes,
depending on the client hardware and the number of components that need to be
installed. For example, if Polaris has not been installed on the workstation
previously and most or all of the components must be installed, the entire
installation process may take up to 10 minutes.
When the necessary prerequisites have been installed, the client installation
Welcome screen opens.

3. Select Next to continue.
The License Agreement dialog appears.
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4. Select I accept the terms in the license agreement, and select Next.
The Customer Information dialog appears.

5. Type the appropriate information in the User Name and Organization boxes.
6. Select a user permission option, and select Next.
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The Custom Setup dialog appears.

7. Select or deselect which Polaris software components to install.
By default, only staff client (Polaris ILS) software is set to be installed. If you are
installing other Polaris software, you must select and deselect the components as
appropriate. A red X indicates that a component will not be installed unless you
deliberately select it for installation.
Example:
To install Polaris ExpressCheck only, select Polaris ILS, and select
This feature will not be available from the menu. This prevents the
staff client installation. Then select Polaris ExpressCheck, and
select This feature will be installed on local hard drive from the
menu.
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l

If you are installing staff client software on a workstation that will use RFID
circulation, select Enable RFID from the list under Polaris ILS.

l

If this workstation will also run Leap with RFID, selecte Leap Integrated
under Enable RFID. (For information about Leap with RFID on workstations
without the Polaris staff client, see Integrated RFID for Workstations Running
Leap (No Staff Client).)
Note:
When Enable RFID is selected, the Polaris RFID Utility is also
installed automatically; a Polaris RFID Utility shortcut icon
appears on the desktop when the installation is finished. Use
this utility to write item barcode and related information to
RFID tags. The utility also sets the tag’s security bit. For more
information about using the RFID utility, see the Polaris RFID
Conversion Utility Guide, available on the Polaris Customer
Supportal.
Important:
TCP port 8075 is used by the Security Manager (see Security
Manager). This port must be open if any security measures
(RFID, EM, AV Locker) are used.

l

If you are installing staff client software on a 32-bit Windows workstation
that will use a MagTek® serial credit card reader, select Enable Serial
CreditCard Reader from the list under Polaris ILS. For more information
about setting up staff client workstations for credit card processing, see the
Polaris staff client help.
Note:
If your credit card reader is not a MagTek serial reader, or you
are installing client software on a 64-bit Windows workstation,
do not select Enable Serial CreditCard Reader. (The MagTek
Mini Swipe driver is not compatible with 64-bit versions of
Windows.) Instead, select Enable Keyboard Emulation
Creditcard Reader. You can use any swipe reader that
supports keyboard emulation and returns the swipe data in
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ISO 7813 format followed by a CR. See Credit Card Reader for
details.
l

If you are installing staff client software on a workstation that will
communicate with a Bibliotheca SmartDispenser200™ media dispenser,
select Enable DiscXpress2 from the list under Polaris ILS. For more
information about setting up media dispenser processing, see the Polaris
staff client help.

l

If you will use this workstation to modify the pronunciation of certain words
in SAPI telephony messages, select Text-to-Speech Lexicon Editor. See
Telephony Text-to-Speech (TTS) Editor.

l

To install the SIP or NCIP services, select This feature will be installed on
local hard drive from the drop-down menu for the Polaris SIP or Polaris NCIP
option.
Important:
The Polaris SIP (self-check), Polaris NCIP, and Polaris
ExpressCheck options are not installed unless you specify
their installation. You can install them independently of the
staff client software.

l

To install the Polaris ExpressCheck application on a Polaris ExpressCheck
self-check workstation, select This feature will be installed on local hard
drive from the drop-down menu for the Polaris ExpressCheck option. If this
workstation will use a MagTek serial credit card reader, select Enable Serial
Creditcard Reader under Polaris ExpressCheck, and select This feature and
all subfeatures will be installed from the drop-down menu.
Important:
If you are installing ExpressCheck with credit card support on
a SeePoint unit, select Enable Serial Creditcard Reader. If you
are installing ExpressCheck with credit card support on an
NCR unit, select Enable Keyboard Emulation Creditcard
Reader.
Note:
If your credit card reader is not a MagTek serial reader, do not
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select Enable Serial CreditCard Reader. Instead, select Enable
Keyboard Emulation Creditcard Reader. You can use any swipe
reader that supports keyboard emulation and returns the
swipe data in ISO 7813 format followed by a CR. See Credit
Card Reader for details.
l

If this workstation will read item RFID tags, select Enable RFID under Polaris
ExpressCheck, and select This feature and all subfeatures will be installed
from the drop-down menu. If this workstation will also read patron RFID
cards, select Enable RFIDPatron Cards under Polaris ExpressCheck, and
select This feature and all subfeatures will be installed from the drop-down
menu. For details, see the Polaris ExpressCheck Administration Guide.
Important:
You should also select this option if you will use ITG’s EM
(electromagnetic) security.
Important:
TCP port 8075 is used by the Security Manager (see Security
Manager). This port must be open if any security measures
(RFID, EM, AV Locker) are used.
Note:
When Enable RFID is selected, the Polaris RFID Utility is also
installed automatically; a Polaris RFID Utility shortcut icon
appears on the desktop when the installation is finished. Use
this utility to write item barcode and related information to
RFID tags. The utility also sets the tag’s security bit. For more
information about using the RFID utility, see the Polaris RFID
Conversion Utility Guide, available on the Polaris Customer
Supportal.

l

If this workstation will communicate with an Bibliotheca
SmartDispenser200™ media dispenser, select Enable DiscXpress2 under
Polaris ExpressCheck , and select This feature and all subfeatures will be
installed from the drop-down menu. You can select this feature together with
or independently from other ITG options. For more information about media
dispenser processing, see the Polaris ExpressCheck Administration Guide.
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l

If this workstation will be used to take inventory with Polaris Inventory
Manager (PIM), select Polaris Inventory Manager, and select This feature
and all subfeatures will be installed from the drop-down menu. For more
information about PIM, see the Polaris Inventory Manager Guide.

8. Select Next on the Custom Setup dialog.
The Offline Transactions Folder Files dialog appears.

9. If you want offline transaction files for the staff client to be stored in a location
other than the default, specify the location and then select Next.
The Server Information dialog appears.
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10. Type the application server name in the Application Server Name box.
11. If you are running Polaris in an ASP environment, select the Datalink Name
checkbox, and type the datalink name in the box. See Polaris for Consortia for
more information.
12. If the client computer is running in a Workgroup environment, or authenticates to a
different domain controller than the domain that Polaris runs in, do these steps:
l

Select the Enable Workgroup Mode checkbox.

l

Type the workgroup name or authenticating domain name (the domain that
Polaris runs in) in the Authenticating Domain box.

See Polaris Authentication for more information.
13. If the staff client or ExpressCheck workstation uses a serial credit card reader,
type the port number to which the reader is connected. This option is available
only if you selected Enable Serial Creditcard Reader under Polaris ILS or Polaris
ExpressCheck on the Custom Setup dialog.
14. Select Next.
15. If you selected an RFID option to install—staff client with Enable RFID checked or
Polaris ExpressCheck with Enable RFID checked—the RFID Configuration dialog
appears.
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Select your RFID vendor in the RFID vendor box, and select RFID.
If you selected Bibliotheca, select one of the following options, as appropriate for
your Bibliotheca equipment setup:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Bibliotheca installation
supports patron RFID tags.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once.

l

Targeted security - Select this option for the ability to set RFID security to off
for certain items in a stack of items. If the option is not selected, RFID
security is set to off for the entire stack of items on the reader.

l

EM - Select this option if your ITG installation supports electromagnetic (EM)
security, where magnetic strips on materials are desensitized when they are
successfully checked out.
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l

Audio-Visual Locker - Select this option if your installation supports an AV
locker that unlocks to deliver specified materials when they are successfully
checked out.

If you selected Envisionware, select from the following options, as appropriate for
your EnvisionWare equipment setup:

l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Envisionware installation
supports patron RFID tags.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once. However, the security bit is turned off in all the Envisionware RFID
tags on the antenna pad with that barcode.

If you selected 3M, select from the following options, as appropriate for your 3M
equipment setup:
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l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Envisionware installation
supports patron RFID tags.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once.

l

Tag Format - Select 3M Alphanumeric Item (default) or 3M Numeric Item,
as appropriate for your 3M RFID item tag format.

16. If you selected Polaris NCIP to install, the NCIP Configuration dialog appears.
Select the ports this client will use and change the port numbers if necessary.
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17. Select Next on the NCIP Configuration box.
If you are installing Polaris ExpressCheck, the Polaris ExpressCheck Configuration
dialog appears.
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If you want the Polaris ExpressCheck client software to start automatically when
the Polaris ExpressCheck workstation is rebooted, select Enable Polaris
ExpressCheck Auto Logon. Then supply the appropriate information in the User
Name, Password, Verify Password, and Domain Name boxes, and select Next.
The Ready to Install the Program dialog appears.
18. Select Install to start the installation.
The automatic installation process starts. If you are installing the staff client or
Polaris ExpressCheck with RFID, or the Polaris RFID Utility, installation dialogs may
appear for the USB reader or USB dongle device drivers. Follow the prompts. The
Installation Complete dialog appears when the installation is finished.
19. Select Finish to close the InstallShield Wizard.
The appropriate shortcut icons appear on the desktop.

Related Information
l

Check installation - See Verify the staff client installation.

l

Configuring Polaris - After installing the client software, you configure Polaris
through Polaris Administration in the staff client. For details, see the Polaris staff
client help.

Verify the staff client installation
Follow these steps to verify that the Polaris staff client was installed correctly on staff
workstations.

1. Double-click the Polaris ILS staff client icon

on the desktop.

The Polaris Shortcut Bar and Polaris Log On dialog appear.

2. Select Cancel on the Log On dialog.
3. Select Help > About Polaris from the Polaris Shortcut Bar.
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The About Polaris dialog appears. You should see the correct version number in
the second line, and the appropriate Application Server name.

Note:
Select the Application Server link to see the licenses currently active
for your organization.

Related Information
Log-On Server Cues - You can set an alert message to alert the user that he or she is
attempting to log on to the staff client on the training server, and once the user has
logged on, to indicate the log-on server through custom colors on the title bars of staff
client workforms. With this feature, the user can do such tasks as comparing data from
a production and a training environment, easily identifying the data from each client. For
example, the user may wish to display parallel workforms from both servers, so that
Polaris Administration settings and data can be copied from one to the other. See
“Visual Cues for Staff Client Log-On Server” in the Polaris staff client help.

Group Policy Deployment
You can deploy Polaris Client software via Group Policy instead of manually installing
each client.
A Polaris Support Engineer places the following two MSI packages on your server:
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l

Polaris Client Installer.msi - Used to distribute the client during Active Directory
deployment.

l

Polaris Clients 7.2.msi - Used to generate the transform file with the template
MST via ORCA (and nothing else).

You must use a tool such as Microsoft’s ORCA™ to provide an “answer” file (also
referred to as a “transform” or .mst file). When using ORCA, the answer file will be
generated from the MSI package Polaris Clients 7.2.msi using the template
PolarisILS.mst.
After producing the answer file (PolarisClientILS.mst in the following example), all of the
necessary files must be copied to a share that is accessible to workstations on the
network. In the following example, a folder is created on the root of the C: drive called
C:\PolarisAD and it is shared as PolarisClientsAD. The following files must be copied
into this folder:
Note:
Spaces are not allowed in the share name or path. If you include spaces,
the installation will fail.
l

Copy the entire contents of C:\Program Files\Polaris\7.2\Clients to the
C:\PolarisAD folder

l

Copy Polaris Client Installer.msi to the C:\PolarisAD folder

l

Copy the transform file that generated by ORCA—for example,
PolarisClientILS.mst—to the C:\PolarisAD folder. It is important to confirm that this
is the only .mst file in the folder.

Group Policy can now be used to deploy the client. When selecting the MSI package
Polaris Client Installer.msi, do not choose to apply a transform. The transform in the
folder C:\PolarisAD will be automatically applied during the client installation.
When you select the Polaris Client Installer.msi package, this prompt appears:
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Confirm that Assigned is selected, and select OK.
The clients will now deploy.
Note:
The client is deployed in the background after the computer policy is
applied. Users will be able to log onto the workstation while the client
installation is in progress.

System Center Deployment
You can also deploy Polaris Client software via System Center.
A Polaris Support Engineer places the following two MSI packages on your server:
l

Polaris Client Installer.msi - Used to distribute the client during Active Directory
deployment.

l

Polaris Clients 7.2.msi - Used to generate the transform file with the template
MST via ORCA (and nothing else).

You must use a tool such as Microsoft’s ORCA to provide an “answer” file (also referred
to as a “transform” or .mst file). When using ORCA, the answer file will be generated
from the MSI package Polaris Clients 7.2.msi using the template PolarisILS.mst.
After producing the answer file (PolarisClientILS.mst in the following example), all of the
necessary files must be copied to a share that is accessible to workstations on the
network. In the following example, a folder is created on the root of the C: drive called
C:\PolarisAD and it is shared as PolarisClientsAD. The following files must be copied
into this folder:
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l

Copy the entire contents of C:\Program Files\Polaris\7.2\Clients to the
C:\PolarisAD folder

l

Copy Polaris Client Installer.msi to the C:\PolarisAD folder

l

Copy the transform file that generated by ORCA—for example,
PolarisClientILS.mst—to the C:\PolarisAD folder. It is important to confirm that this
is the only .mst file in the folder.

Execute one of the following two commands from the command line:
msiexec /quiet /i "\\servername\PolarisClientsAD\Polaris Client Installer.msi" /log
c:\ClientInstall.log
or
"\\servername\PolarisClientsAD\Polaris Client Installer.exe" /s

The /s switch instructs the EXE installer to be silent.

Automating Polaris Client Deployment
Beginning with Polaris 4.1R2, you can ease client upgrades with the Polaris Client
Deployment tool, a separately licensed fee-based feature. Using the server-side Polaris
Client Deployment console, administrators can deliver (“push”) Polaris client software
upgrades to a specified set of workstations. You save significant time and effort at
installation and upgrade, minimizing or eliminating downtime while you get the latest
from Polaris.
You can also have the upgrade initiated from the client in a passive deployment (“pull”).
Once client software is assigned to be deployed from the designated upgrade server,
the client application performs a version check at startup, and if it is out of version,
prompts the user to upgrade. Depending on how the administrator has set the client
installation requirements, the user can either choose to upgrade or be required to
upgrade. Once the upgrade is initiated, the assigned Polaris client is installed. The
logged-in user does not require administrator rights to install the Polaris client, because
it is installed under an account that has the appropriate rights. If the user chooses not to
upgrade when prompted, the client can function in offline mode. This client-initiated
option ensures that client upgrades that were not deployed successfully from the
console via the push method will be installed when the client is started by the end-user.
With either deployment mode, the Polaris Client Deployment tool reports unsuccessful
client installations and allows you to retry the deployment for those that have failed.
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For more information about obtaining the Polaris Client Deployment Tool, contact
Innovative Interfaces Customer Sales. For detailed information about requirements and
procedures, see “Automating Polaris® Client Deployment,” available on the Polaris
Customer Supportal (https://supportal.polarislibrary.com).

RFID Circulation for Polaris Hosted and Terminal Server Environments
Polaris supports integrated RFID circulation on Polaris workstations that are used in a
hosted environment or otherwise use an RDP connection to Terminal Server. To use this
functionality, you perform a Polaris client installation on the Terminal Server, specifying
Terminal Server as the RFID “vendor,” and then install a standalone Polaris Security
Manager application on the RFID-enabled workstations that will communicate with the
Terminal Server.
Install the client on Terminal Server
Follow these steps to install the Polaris staff client application with RFID on the
Terminal Server.
1. On the Terminal Server computer, navigate to the Polaris staff client setup.exe
application and start the application.
The Welcome screen opens.
2. Select Next.
The License Agreement dialog appears.
3. Select I accept the terms in the license agreement, and select Next.
The Customer Information dialog appears.
4. Type the appropriate information in the User Name and Organization boxes.
5. Select a user permission option, and select Next.
The Custom Setup dialog appears. Polaris ILS, the staff client application, is
enabled by default.
6. Select Enable RFID from the list under Polaris ILS.
7. Select Next.
The Offline Transactions Folder Files dialog appears.
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8. Leave the location set to the default value, and select Next.
The Server Information dialog appears.
9. Type the application server name in the Application Server Name box, and select
Next.
The RFID Configuration dialog appears.
10. Select Terminal Server in the RFID Vendor list.
11. Select Next.
The Ready to Install the Program dialog appears.
12. Select Install to start the installation.
The Installation Complete dialog appears when the installation is finished.
Install the Security Manager on the local workstation
Follow these steps to install the standalone Security Manager application on the local
RFID-enabled workstation.
1. On the local workstation, navigate to the Security Manager setup.exe application
and start the application.
2. If any prerequisites are required, the wizard prompts you to install them. Select
Install.
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When all prerequisites are installed, a Welcome screen appears.
3. On the Welcome screen, select Next.
The License Agreement dialog appears.
4. Select I accept the terms in the license agreement, and select Next.
The Customer Information dialog appears.
5. Type the appropriate information in the User Name and Organization boxes.
6. Select a user permission option, and select Next.
The Custom Setup dialog appears. Polaris Security Manager, the only option, is
enabled by default.
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7. Select Next.
The RFID Configuration dialog appears.
8. Select your RFID vendor in the RFID vendor box, and select RFID.
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9. If you selected Bibliotheca in step 7, select one of the following options, as
appropriate for your Bibliotheca equipment setup:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Bibliotheca installation
supports patron RFID tags.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once.

10. If this workstation runs Polaris ExpressCheck and you selected Integrated
Technology Group (ITG) in step 7, select from the following options, as appropriate
for your ITG equipment setup:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once.

l

Patron tag supported - Select this option if your ITG installation supports
patron RFID tags.

l

Targeted security - Select this option for the ability to set RFID security to off
for certain items in a stack of items. If the option is not selected, RFID
security is set to off for the entire stack of items on the reader.
Note:
The EM (electromagnetic) security and Audio-VIsual Locker options
are not currently supported in Terminal Server or Polaris Hosted
environments.

10. If you selected Envisionware in step 7, select from the following options, as
appropriate for your EnvisionWare equipment setup:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Envisionware installation
supports patron RFID tags.
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l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once. However, the security bit is turned off in all the Envisionware RFID
tags on the antenna pad with that barcode.

11. If you selected 3M, select from the following options, as appropriate for your 3M
equipment setup:
l

USB Reader - Select this option if the workstation uses a USB RFID reader.

l

Patron tag supported - Select this option if your Envisionware installation
supports patron RFID tags.

l

Dedupe item barcodes - Select this option if your library places RFID tags
with duplicate item barcodes on all items in a set. When this option is
selected, at check-out duplicate item barcodes are removed from the list of
RFID tags currently on the antenna pad (reader) so that the set is checked
out once.

l

Tag Format - Select 3M Alphanumeric Item (default) or 3M Numeric Item, as
appropriate for your 3M RFID item tag format.

12. Select Next on the RFID Configuration box.
The Ready to Install the Program dialog appears.
13. Select Install to start the installation.
The Installation Complete dialog appears when the installation is finished.
Accessing Remote Client Logs
Open the remote client Security Manager first, then the Terminal Server Security
Manager. The Terminal Server Security Manager (vendor is set to Terminal Server)
connects to the Client Security Manager at startup.
In the Terminal Server Security Manager, select the Remote Clients Log tab. The window
shows the remote client logs and offers the option to save the logs in the Polaris
Security Manager Log folder. Remote client and Terminal Server log files are saved
separately.
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installing clients
staff 60
installing Polaris
new installation overview 13
installing servers
components 20
installing Polaris files 25
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installing with staff client 65
L
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licenses
overview 10
placing on application server 40
viewing for organization 45, 74
local security policy rights
assigning 17
locale
client/server consistency 48
M
magnetic swipe readers
serial and keyboard emulation, described 58
Mobile PAC
described 22

© 2022 Innovative (Part of Clarivate)
Page 87

Polaris Installation Guide

Multilingual Version
see Polaris PowerPAC Multilingual Version 34
P
PAPI Service
described 21
Swagger 22
password
changing default SQL user 49
PAWS
described 21
Polaris Client Deployment Tool
automating staff client installation 77
Polaris ExpressCheck
installing 65
Polaris Fusion
installing server software 29
Polaris Inventory Manager (PIM)
installing 67
Polaris Language Editor (WebAdmin)
described 23
Polaris PowerPAC
requirements 5
Web server 4
Polaris PowerPAC Children’s Edition
activating 34
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Polaris PowerPAC Multilingual Version
activating 34
Polaris RFID Utility
installing 60
Polaris servers
see servers 25
Polaris SIP
installing 60
Polaris Tools
accessing on server 39
PolarisExec account
creating 18
Domain Administration membership 19
PolarisServices account
creating 15
setting system rights 17
prerequisite software
installing for clients 60
printers
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RFID for Hosted and Terminal Server 78
servers
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Polaris Tools 39
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two-server installation 34
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described 23
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see Polaris SIP 60
SQL user
changing default password 49
staff clients
installing manually 60
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installing with Polaris Client Deployment Tool 77
installing with System Center 76
new installations 52
printing 53
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verifying the installation 73
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Swagger
PAPI Service endpoint 22
System Center
deploying staff client 76
T
tech client
see staff clients 5
telephony
pronunciation 59
server components 20
terminal server
printers 6
time stamps
client/server consistency 48
transactions
staff client log-on 9
TTS Lexicon Editor
overview 59
W
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Web server
installation 34
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setup 7
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